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1 INTRODUCTION

1.1 Purpose
The Sentinel-3 Sea and Land Surface Temperature Radiometer (SLSTR) Marine Handbook is 
a guide that summarises the key information needed for an end-user (both general and 
specialist) to gain a better understanding of the SLSTR marine Level 1 (L1) and Level 2 (L2) 
products. The handbook includes information on the components of the instrument system, the 
specifics of measurement techniques used, details on applied corrections and processing steps 
required to derive geophysical variables. The capability of the system is discussed in the 
context of its complementarity with, and improvements on, other sea surface temperature (SST) 
missions, with notes on existing limitations. A discussion of file formats, processing tools and 
data-access routes precedes a presentation of available support resources. Where the detail is 
not held in the handbook itself, the user is pointed to further (primarily web-based) resources.

1.2 Scope
All current and potential users of the Copernicus Marine Data Stream that are interested in the 
Sentinel-3 SST products for use in the open-ocean, coastal domain and inland waters, including 
rivers and lakes.

1.3 Document Structure
Section 1 General information (this section).

Section 2 Background information on EUMETSAT, Copernicus and Sentinel-3 mission 
requirements.

Section 3 Provides and overview of Copernicus and the SLSTR instrument.

Section 4 Gives an overview of the SLSTR instrument, coverage, quality, capability and 
accuracy 

Section 5 Gives a description of SLSTR L1 and L2 marine processing.

Section 6 Gives a description of SLSTR L1 and L2 marine products.

Section 7 Explains how to download and visualise SLSTR data.

Section 8 Summarises the data quality of SLSTR marine products.

Section 9 Provides details of some unique features of SLSTR and SLSTR marine products 
that all users should be aware of.

1.4 Applicable Documents

AD-1 Sentinel-3 Mission Requirements Document, v2.0 EOP-SMO/1151/MD-md
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AD-2 Sentinel-3 Mission Requirements Traceability 
Document, v1.0

EOP-SM/2184/CD-cd

AD-3 Sentinel-3 PDGS File Naming Convention, v1D EUM/LEO-
SEN3/SPE/10/0070

1.5 Reference Documents

RD-1 Allison, L.J., and J. Kennedy, 1967. An Evaluation of Sea Surface Temperature as 
Measured by the Nimbus I High Resolution Infrared Radiometer,” NASA 
Technical Note No. D-4078, National Aeronautics and Space Administration, 
Washington, D.C.

RD-2 Donlon C., N. Rayner, I. Robinson, D. J. S. Poulter, K. S. Casey, J. Vazquez-
Cuervo, E. Armstrong, A., Bingham, O. Arino, C. Gentemann, D. May, P. 
LeBorgne, J. Piollé, I. Barton, H. Beggs, C. J., Merchant, S. Heinz, A. Harris, G. 
Wick,B. Emery, P. Minnett, R. Evans, D. Llewellyn-Jones, C., Mutlow, R. W. 
Reynolds, H. Kawamura, 2007. The Global Ocean Data Assimilation Experiment 
High-resolution Sea Surface Temperature Pilot Project, Bulletin of the American 
Meteorological Society, Volume 88, Issue 8 (August 2007) pp. 1197-1213 doi: 
http://dx.doi.org/10.1175/BAMS-767 88-8-1197.

RD-3 P. Le Borgne, A. Marsouin, F. Orain, H. Roquet, 2012. Operational sea surface 
temperature bias adjustment using AATSR data, Remote Sensing of Environment, 
116, 93-106. doi:10.1016/j.rse.2010.02.023.

RD-4 Závody, A.M., Mutlow, C.T., and Llewellyn-Jones, D.T., 1995. A Radiative 
Transfer Model for Sea Surface Temperature Retrieval from the Along-Track 
Scanning Radiometer. Journal of Geophysical research, 100, 937-952.

RD-5 Merchant, C.J., Harris, A.R., Murray, M.J., and Závody, A.M., 1999. Toward the 
Elimination of Bias in Satellite Retrieval of Sea Surface Temperature 1. Theory, 
Modelling and Interalgorithm Comparison. Journal of Geophysical Research, 104, 
23565-23578.

RD-6 Bulgin, C.E., O. Embury, G. Corlett, C.J. Merchant, 2015. Independent uncertainty 
estimates for coefficient based sea surface temperature retrieval from the Along-
Track Scanning Radiometer, Remote Sensing of Environment, 162, 396-407

1.6 List of acronyms and abbreviations
Table of key acronyms and abbreviations. 

AATSR
ATBD

Advanced Along-Track Scanning Radiometer
Algorithm Theoretical Basis Document

Cal/Val Calibration and Validation
CMEMS Copernicus Marine Environment Monitoring Service
CODA Copernicus Online Data Access
ECMWF European Centre for Medium-Range Weather Forecasts



EUM/OPS-SEN3/MAN/17/921927
v1E e-signed, 4 July 2018

Sentinel-3 SLSTR Marine User Handbook

This Document is Public

Page 8 of 39

EO Earth Observation
EOP Earth Observation Portal
EUMETSAT European Organisation for the Exploitation of Meteorological Satellites
FTP File Transfer Protocol
GHRSST Group for High Resolution SST
GMES Global Monitoring for Environment and Security
IR Infrared
L1 Level 1
L2 Level 2
LST Land Surface Temperature
MDB Match-up Database
METIS
MPC

Monitoring and Evaluation of Thematic Information from Space 
Sentinel-3 Mission Performance Centre

MRD Mission Requirements Document
MRTD Mission Requirements Traceability Document
MWR Microwave Radiometer
NDVI Normalised Difference Vegetation Index
NeDT Noise Equivalent Differential Temperature
NetCDF Network Common Data Format
NRT Near Real-Time
NTC
NWP

Non-Time Critical
Numerical Weather Prediction

OSI SAF Ocean and Sea Ice Satellite Application Facility
PDGS Payload Data Ground Segment
PDU Product Dissemination Unit
POD Precise Orbit Determination
RBT
RTTOV

Radiance Brightness Temperature
Radiative Transfer model for the TIROS Optical Vertical sounder

S3VT Sentinel-3 Validation Team
SAFE Standard Archive Format for Europe
SLSTR Sea and Land Surface Temperature Radiometer
SNAP SeNtinel Application Platform
SRAL Synthetic Aperture Radar Altimeter
SST Sea Surface Temperature
STEP Science Toolbox Exploitation Platform
SWIR Short-wave Infrared
TIR Thermal Infrared
TOA Top of Atmosphere
VISCAL Visible Calibration
VNIR Visible Near Infrared
WCT Internal individual algorithms Sea Surface Temperature
WST GHRSST L2P format Sea Surface Temperature
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2 BACKGROUND 

2.1 The Copernicus Programme
Copernicus is the European programme for the establishment of a European capacity for Earth 
observation and monitoring. The programme aims to deliver information services based on 
satellite and in situ (non-space) components. The Copernicus Programme is coordinated and 
managed by the European Commission. It is implemented in partnership with the Member 
States, the European Space Agency (ESA), the European Organisation for the Exploitation of 
Meteorological Satellites (EUMETSAT), the European Centre for Medium-Range Weather 
Forecasts (ECMWF), EU Agencies and Mercator Océan. The Copernicus programme provides 
users with free, full and open access to environmental data.

The satellite component of the Copernicus Programme encompasses the Sentinel satellite 
missions, including Sentinel-3. Sentinel-3 is dedicated to providing high-accuracy optical, 
radar and altimetry data for marine and land services. EUMETSAT operates the Sentinel-3 
satellite series, with ESA support, and is responsible for delivering the Sentinel-3 marine data 
stream. Looking ahead, EUMETSAT will also will also operate and deliver products from the 
Sentinel-4, and Sentinel-5 instruments, and the Sentinel-6/Jason-CS satellites.

2.2 European Organisation for the Exploitation of Meteorological Satellites 
(EUMETSAT)

Founded in 1986, EUMETSAT is a European-based and globally-focussed, intergovernmental 
operational satellite agency. Its purpose is to gather accurate, reliable and timely satellite data 
on weather, climate and the environment, and to deliver this to its Member and Cooperating 
States, international partners, and to users world-wide. With a strategic goal to ensure 
improvements in, and continuity of, satellite observations, EUMETSAT oversees the 
development and operation of a range of complex satellite systems that are in constant use in 
monitoring weather, climate, the oceans and the atmosphere, and supports downstream services 
such as meteorological forecasting, air-travel safety and shipping.

EUMETSAT operates a fleet of satellites in geostationary and polar orbit from its Mission 
Control Centre (MCC), based at its headquarters in Darmstadt, Germany. The geostationary 
Meteosat platforms provide regular imagery over Europe, Africa and the adjacent seas, 
(Meteosat-9, 10 and 11), and over the Indian Ocean (Meteosat-8). More detailed observations 
of the global atmosphere, oceans and continents are provided by the polar orbiting Metop-A 
and Metop-B satellites. In partnership with NOAA, CNES and NASA, EUMETSAT supports 
the operational phase of the Jason-2 altimeter and the Jason-3 reference altimeter, providing 
near real-time ocean topography products to support ocean forecasting and climate analysis.

Under the Copernicus Programme, EUMETSAT provides Earth Observation (EO) data, 
products and support services to the Copernicus information services and user communities, 
with a focus on marine, atmosphere and climate. In the marine context, this role encompasses 
operating the Sentinel-3 and Jason-3 satellites, with future responsibility for Sentinel-6/Jason-
CS. The marine capability of the Sentinel-3 SLSTR instrument is the sole focus of this 
document.
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2.3 Sentinel-3 objectives
Sentinel-3 is a dedicated Copernicus satellite delivering high-quality ocean measurements. In 
the marine environment, the primary objective of Sentinel-3 is to determine sea-surface 
topography, sea-surface temperature and ocean-surface colour parameters; offering EO data 
with global coverage every two days (with two satellites) in support of marine applications, 
and with near real-time products delivered in less than three hours.

Sentinel-3A and 3B were launched in February 2016 and April 2018, respectively. Sentinel 3B 
is currently in the commissioning phase, flying in tandem with Sentinel 3A, 30 seconds apart 
on the same orbital track. Sentinel 3B will complete transit to its final orbital track and move 
to its operational phase in autumn 2018. In the longer term the Sentinel-3 mission will have 
further satellites (Sentinel-3C and Sentinel-3D), extend this global monitoring. Requirements 
of the Sentinel-3 mission include:

 Sea surface temperature (SST) determined globally to an equivalent accuracy and 
precision as that presently achieved by A/ATSR (i.e. <0.3 K), at a spatial resolution of 
1 km.

 Visible and Thermal Infrared radiances (’Ocean Colour’) for oceanic and coastal 
waters, deter- mined to an equivalent level of accuracy and precision as MERIS data 
with complete Earth cover- age in two to three days, and co-registered with SST 
measurements.

 Sea surface topography (SSH) and, significant wave height (SWH) over the global 
ocean to an accuracy and precision exceeding that of Envisat RA-2.

For more information, users should consult the specific objectives for the Sentinel-3 missions. 
These are defined in the Mission Requirements Document (MRD) [AD-1], which is adopted 
in a traceable format through the Mission Requirements Traceability Document (MRTD) [AD-
2]. The Copernicus Marine Environment Monitoring Service (CMEMS) provides regular and 
systematic core reference information on the state of the physical and biological oceans and 
regional seas to support marine applications. The products come from both EO data and 
numerical modelling.

2.4 Disclaimer
The use of these products is granted to every interested user, free of charge.  EUMETSAT is 
very much interested in receiving your feedback, would appreciate your acknowledgement in 
using and publishing about the data, and like to receive a copy of any publication about the 
application of the data. Your feedback helps us in improving product quality and maintaining 
the resources for the EUMETSAT marine services.
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2.5 Useful links 
EUMETSAT Copernicus homepage:

https://www.eumetsat.int/website/home/Satellites/FutureSatellites/CopernicusSatellites/ 
CopernicusResources/

EUMETSAT Sea Surface Temperature homepage:
https://www.eumetsat.int/website/home/Data/CopernicusServices/Sentinel3Services/ 
SeaSurfaceTemperature/index.html

EUMETSAT YouTube home:
https://www.youtube.com/channel/UCiN59j5b1fAGnXVzIYFpaMw

Copernicus YouTube playlist:
https://www.youtube.com/playlist?list=PLOQg9n6Apif1ODObv39j43j8IAvJDOAVY 

How to access Copernicus sea surface temperature data:
https://youtu.be/lKyUeN3uS0Q

Sentinel-3 for oceans:
https://www.youtube.com/watch?v=T9WCWnk_qN4

Sentinel-3 playlist:
https://www.youtube.com/playlist?list=PLbyvawxScNbus9n8rmw0GElhPqrCwcsiD

2.6 Limitations of the SLSTR SST Products
Information on product status, quality and limitations can be found through the following link:
https://www.eumetsat.int/website/home/Data/CopernicusServices/Sentinel3Services/SeaSurfa
ceTemperature/index.html)

2.7 History of product changes 

A history of changes to products can be found in the relevant product notice and specification 
document via the following link:

https://www.eumetsat.int/website/home/Data/CopernicusServices/Sentinel3Services/ 
SeaSurfaceTemperature/index.html

Current and previous Sentinel-3 mission reports can be found via the following link: 
https://sentinels.copernicus.eu/web/sentinel/missions/sentinel-3/mission-status
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3 SENTINEL-3 AND SLSTR
The Sentinel-3 missions are low earth polar orbiting satellites, operating at an average altitude 
of 815 km above the Earth’s surface with a repeat cycle of 27 days. Sentinel-3B is currently in 
in a "tandem orbit", occupying the same ground track as Sentinel-3A with a 30-second 
difference in observations, to enable close inter-calibration of the instruments. In autumn 2018 
it will be moved to a position 140o later in its orbit that will mean that the ground tracks of 
Sentinel-3B and Sentinel-3A are "interleaved", giving a more complete and even sampling of 
the Earth’s surface, so as to better fulfil the monitoring role of the Sentinel missions. They 
carry three sets of instruments focusing on high-accuracy optical, thermal and altimetry data 
for marine and land services:

 Thermal: Sea and Land Surface Temperature Radiometer (SLSTR) for marine and 
terrestrial thermal measurements.

 Optical: OLCI for medium resolution marine and terrestrial optical measurements
 Altimetry: SAR Radar ALtimeter (SRAL) together with the MicroWave Radiometer 

(MWR) and Precise Orbit Determination (POD) for topography measurements.

The handbook is concerned with the thermal radiometry component, and covers applications 
in the marine domain (open ocean and coastal) and for inland water bodies, including rivers 
and lakes.

3.1 Sea surface temperature: a historical background
The first measurements of sea surface temperature (SST) from space were largely delivered as 
a bi-product of early efforts to remotely monitor, and forecast, weather. However, although the 
nominal goal of early missions such as the Nimbus series (Nimbus-1; launched in 1964) was 
atmospheric and cloud characterisation, it soon became apparent to researchers that, in clear 
scenes, their radiometry data could provide information on surface temperatures, also. Since 
the early 1970s, data from the ever-improving Nimbus and ITOS satellites, began to provide a 
global picture of SST, albeit one that was sparsely populated (due to low coverage and short 
instrument life), coarse resolution, subject to substantial RMS errors, and subject to multiple 
sources of contamination. However, by the mid-1970s, the concept of infrared measurement of 
SST had been sufficiently proven.

In 1978, step-change in capability was achieved with the launch of the first advanced very high-
resolution radiometer (AVHRR), then a four-channel imager, aboard NOAA’s TIROS-N 
satellite. Since then, AVHRR has formed one of the mainstays of satellite-based SST 
measurement, later upgrading to 5 (AVHRR/2) and 6 channel (AVHRR/3) instruments by 
1998, and still in orbit on NOAA-18, NOAA-19, Metop-A and Metop-B (both operated by 
EUMETSAT) today.

Multiple other developments occurred in parallel, bring increased coverage in the IR spectrum 
and adding microwave capabilities. The 1998 and 2002 launches of the NASA Terra and Aqua 
satellites added not only the infrared imaging capability of the Moderate Resolution Imaging 
Spectroradiometer (MODIS, also an ocean colour sensor), but also the Advanced Microwave 
Scanning Radiometer (AMSRE). The latter provided a new way to derive SST that was 
immune to cloud contamination, with the caveat of lower spatial resolution. The Visible 
Infrared Imaging Radiometer Suite (VIIRS) aboard the Suomi-PP weather satellite has also 
delivered SST data since 2011.
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Life for the Along Track Scanning Radiometer (ATSR-1) radiometer, the historical precursor 
series to SLSTR (which is on Sentinel-3) began with the 1991 ESA launch of ERS-1. This was 
quickly followed by ATSR-2 on ERS-2 in 1995 and AATSR (which introduced the dual view 
approach, and of which SLSTR is the direct antecedent) on ENVISAT in 2002.

Incremental improvements in sensor technology and a synergy between microwave and 
infrared approaches have resulted in huge gains in measurement precision and thermal stability, 
ever increasing coverage and spatial resolutions, substantial improvements in correcting for 
atmospheric conditions, and, at lower resolution the ability to measure irrespective of cloud-
cover.

3.2 Complementarities with other SST missions
The retrieval of sea surface temperature (SST) from satellite-based infrared (IR) radiometers 
was first reported in 1967 [RD-1]. Since then many instruments have flown and the provision 
of sea SST data for operational oceanography by the Group for High Resolution SST, GHRSST 
[RD-2], has grown to a mature sustainable and essential service. The GHRSST partners offer 
a suite of tailored global high-resolution SST products, in near-real-time, daily, to support 
operational forecast systems and the broader scientific community.

SST is the kinetic temperature of a water body at a defined depth. Although SLSTR measures 
a radiometric temperature it is provided as a kinetic temperature by considering the emissivity 
of the water body as part of the SST retrieval process. Due to the limited penetration of thermal 
infrared (IR) radiation through the water column, the IR radiometric temperature measured by 
SLSTR is that of only the top few tens of micrometres referred to as the skin temperature. At 
night, the skin temperature is typically a few tenths of a degree cooler than the temperature 
measured by in situ systems; in the day, the skin can be considerably higher if strong diurnal 
warming is present. For more details please see “What is SST?” on the GHRSST web pages 
(https://www.ghrsst.org/ghrsst-data-services/products/). 

GHRSST relies on SST data from both space and in situ measurement systems. From space, 
SST can be estimated from radiometric wavelengths in the so-called atmospheric window 
regions, regions in the black-body emission of the Earth that are least sensitive to the 
atmosphere. These occur in the IR and microwave regions although the lower signal strength 
from the Earth’s Planck radiation curve in the microwave region results in lower accuracy than 
that achievable in the IR.

In addition to multiple wavelengths it is possible to obtain SST from satellites operating in 
different orbits. Currently, IR sensors operate in both low and geostationary Earth orbits; 
microwave are limited to low Earth orbit for now owing to the low signal. This means GHRSST 
relies on data form three types of satellite radiometer:

 Polar orbit IR

 Polar orbit microwave

 Geostationary orbit IR

All the data available to GHRSST requires some means of reference field to provide the best 
possible estimate from the ensemble. This is usually in situ data but previous work with 
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AATSR demonstrated that a satellite radiometer could be used if it was sufficiently accurate 
[RD-3]. This is where SLSTR comes in – as the successor to AATSR in providing reference 
quality SSTs from space. For this, SLSTR has three unique features:

 A dual-view for improved atmospheric correction

 Highly stable cooled detectors

 Two on-board black bodies for calibration of each scan

In addition to providing reference quality SSTs in the dual-view part of the swath (700 km), 
SLSTR also provides nadir-only SSTs over the remaining swath (up to 1400 km).
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4 SLSTR: GEOPHYSICAL VARIABLES, INSTRUMENTS AND PRINCIPLE

4.1 The SLSTR instrument

SLSTR is a dual-view multichannel satellite radiometer. It has nine spectral bands that detect 
top of atmosphere (TOA) radiation in the VNIR/SWIR/TIR regions, which are summarised in 
Table 1 below. 

Band λ centre 
(μm)

Width 
(μm) Function Comments Res. (m)

S1 0.555 0.02 Cloud screening, vegetation 
monitoring, aerosol

S2 0.659 0.02 NDVI, vegetation monitoring, 
aerosol

S3 0.865 0.02 NDVI, cloud flagging, Pixel 
co-registration

Visible 
Near IR
(VNIR)

S4 1.375 0.015 Cirrus detection over land

S5 1.61 0.06 Cloud clearing, ice, snow, 
vegetation monitoring

S6 2.25 0.05 Vegetation state and cloud 
clearing

Short-Wave 
IR

(SWIR)

Solar reflectance 
bands 500

S7 3.74 0.38 SST, LST, Active fire
S8 10.85 0.9 SST, LST, Active fire
S9 12 1 SST, LST

Thermal IR bands
(TIR)

F1 3.74 0.38 Active fire
F2 10.85 0.9 Active fire

Thermal IR fire bands
(TIRf)

1000

Table 1: SLSTR Spectral Bands

Although primarily designed for sensing the temperature of the Earth’s surface, the additional 
bands at shorter wavelengths are required to aid with removing cloud and aerosol from the 
temperature estimate; in turn, by characterising the surface, these additional channels can then 
be exploited to provide estimates of cloud and aerosol geophysics as well.

The SLSTR instrument exploits two independent scan chains to provide a wider instrument 
swath than its predecessor ATSR’s but maintaining a common angle of incidence. The two 
swaths have slightly different coverage:

 Nadir view swath is ~ 1400 km across track

 Oblique view swath is ~ 740 km across track
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Figure 1: SLSTR swath coverage. Note that, unlike in AATSR, the oblique view in SLSTR is to the rear (e.g. 
behind the direction of flight)

SLSTR products are generated separately in the two instrument views, and at two spatial 
resolutions, depending on optical channels:
 

 500 m resolution for solar reflectance bands S1 to S6

 1 km resolution for thermal infrared bands S7 to S9 and F1 & F2

Owing to its conical scan geometry, the SLSTR products are provided on a nominal raster 
image grid through nearest neighbour resampling and not in their original orientation. 
However, the products do contain the required information to reconstruct the original scan 
locations if a user deems it necessary for their application.

The SLSTR nadir swath is asymmetrical with respect to its sub-satellite point (SSP) to provide 
identical and contemporaneous coverage with OLCI ocean/land colour measurements. The 
SSP is in the centre of the grid in the oblique view. To find the SSP you can either (1) use the 
field track_offset in the product or manifest file, or (2) find the point at which the Cartesian x-
coordinate is minimal.
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4.2 Coverage
Sentinel-3A is in a sun-synchronous orbit with a mean altitude of 815 km, completing 385 
orbits (i.e. 770 pole-to-pole tracks) in exactly 27 days. Sentinel-3B, launched in April 2018, is 
currently in "tandem phase" for close calibration with Sentinel-3A, but will subsequently be 
moved to a set of tracks interleaving those of Sentinel- 3A to give a denser pattern of coverage. 
This will occur in autumn 2018. Sentinel-3B will retain the orbital characteristics of Sentinel-
3A, but ±140o out of phase. The mean global coverage revisit time for dual view SLSTR 
observations is 1.9 days at the equator (one operational spacecraft) or 0.9 days (in constellation) 
with these values increasing at higher latitudes due to orbital convergence.

4.3 Measurement of SST from SLSTR
The SLSTR series of instruments have three spectral bands that are used for SST retrieval, with 
nominal band centres at 3.7 µm, 11 µm and 12 µm. During the day, the 3.7 µm channel is not 
used due to solar contamination and so, as each Earth scene is viewed in both nadir and off-
nadir, there are four possible retrieved SSTs, referred to as N2 (nadir-only 11 µm and 12 µm), 
N3 (nadir-only 3.7 µm, 11 µm and 12 µm), D2 (dual-view 11 µm and 12 µm) and D3 (dual-
view 3.7 µm, 11 µm and 12 µm). The N2, N3, D2 and D3 nomenclature is used through the 
rest of this report. A fifth retrieval algorithm, N3R is similar to N3, but uses the property of 
“aerosol robustness”, which is applicable in areas of high atmospheric aerosol content, e.g. near 
volcanoes. In practice, N3R is not routinely used. Note: The L2P product only contains the best 
SST available and does not therefore contain nadir-view only SSTs.

The retrieval scheme itself uses linear regression algorithms with coefficients derived from 
radiative transfer models (see for example [RD-4, RD-5]) that perform a linear regression of 
SST to simulated brightness temperatures (BTs) at the nominal band centres. Multiple channels 
are used for atmospheric correction (mainly water vapour) with the use of multiple views 
accounting for aerosol effects.

4.4 SLSTR products
SLSTR Level-1 RBT and Level-2 WST data products are freely available to the public. The 
SLSTR files are collected into a SAFE container containing free-standing NetCDF-4 format 
files. The timeframe for delivery of products is dependent on specific applications:

 Near Real-Time (NRT) products, are available in less than 3 hours after acquisition of 
data by the sensor.

 Non-Time Critical (NTC) products, are available not later than 1 month after 
acquisition or from long-term archives. Typically, the product should be available 
within 24h or 48h (but this not guaranteed).

4.4.1 Expected accuracy
The expected accuracy is defined as the expected bias and standard deviation of the primary 
calculations. The accuracy is validated against in situ measurements from buoys, platforms, or 
ship, and against NWP data.
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All products contain uncertainty estimates in two types:

1. GHRSST SSES
These are standard GHRSST Single Sensor Error Statistics (SSES) bias and standard 
deviation estimates from comparison to in situ data. As of April 4th, 2018, the SSES error 
statistics have been updated to reflect the inclusion of the Bayesian cloud detection 
algorithm. More information is available on the product notice page:

https://www.eumetsat.int/website/home/Data/CopernicusServices/Sentinel3Services/ 
SeaSurfaceTemperature/index.html

2. Theoretical uncertainties
These are experimental estimates of the SST uncertainty calculated per pixel from the 
output of the radiative transfer modelling. The scheme is based on [RD-6]. These are 
preliminary and will be subject to further investigation/optimisation.

The Sentinel-3 Mission Requirements Document [AD-1] states that: 

 Sentinel-3 shall provide SST measurement capability to at least the quality of AATSR 
on Envisat: SST shall be accurate to < 0.3 K @ 1 km spatial resolution and with 
improved swath coverage). [S3-MR-400].

 Sentinel-3 SST measurements shall have a long-term radiometric stability goal of 0.1 
K/decade (≤ 0.2 K/decade threshold) for a 5 x 5 latitude longitude area. [S3-MR-980].

A summary of current data quality and estimated accuracy is given in Section 8.

4.5 Quality control and monitoring
Quality control and monitoring of SLSTR is carried out by several entities. The Mission 
Performance Centre (MPC) is responsible for calibration, validation, quality control and end-
to- end system performance assessment. The MPC includes the SLSTR Expert Support 
Laboratory (ESL) for specific calibration/validation, off-line quality control and algorithm 
correction and evolution activities. The primary method for reporting of data quality is the 
SLSTR Cyclic Report. These are generated every cycle (roughly every 27 days or 501 orbits) 
and can be downloaded from:

https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-3-slstr/data-quality-reports.

EUMETSAT also supports additional quality control and monitoring for the SLSTR marine 
products. This comes in two forms:

 The SLSTR Match-up Database (MDB)
The SLSTR MDB contains temporal and spatial coincidences between SLSTR and various 
reference dataset, e.g. drifting buoys. It is generated by the EUMETSAT Ocean and Sea 
Ice Satellite Application Facility (OSI-SAF).

 Monitoring & Evaluation of Thematic Information from Space (METIS)
The Monitoring and Evaluation of Thematic Information from Space (METIS) tool is 
developed to monitor EUMETSAT operational remotely sensed products for stability, 
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quality and performance on a global and regional basis in routine. The METIS-SST module 
provides near-real time diagnostics of all EUMETSAT operational L2 satellite SSTs: 
Sentinel-3A SLSTR, METOP-B AVHRR and METOP-B IASI.

You can access METIS at http://metis.eumetsat.int/. 

4.6 Where to go for further information (ATBDs)
The details of all SLSTR algorithms are provided in within an Algorithm Theoretical Basis 
Document (ATBD). For SLSTR Marine products the relevant documents are publically 
accessible from EUMETSAT’s Copernicus Sea Surface Temperature webpage1.

SLSTR Level 2 SST ATBD SLSTR-ATBD-L2SST-v2.5
SLSTR Level 1 ATBD S3-TN-RAL-SL-032 Version 2
Sentinel-3 Product Data Format Specification S3IPF.PDS.005 Version 2.3

In addition, interested readers may wish to consult the ESA user and technical guides for 
additional details:

ESA SLSTR User guide https://earth.esa.int/web/sentinel/user-guides/ 
sentinel-3-slstr 

ESA SLSTR Technical guide https://earth.esa.int/web/sentinel/technical-guides/ 
sentinel-3-slstr 

1 EUMETSAT’s sea surface temperature webpage: 
http://www.eumetsat.int/website/home/Data/CopernicusServices/Sentinel3Services/SeaSurfaceTemperature/ind
ex.html 
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5 PROCESSING LEVELS AND SCHEMES
The SLSTR operational processor is divided into three major processing levels:

 Level 0
This step processes raw data contained in instrument source packets. Level 0 products 
are internal products, and are not disseminated to users.

 Level 1
This step processes the Level 0 data to geo-located radiometric measurements for each 
SLSTR channel/view.

 Level 2
This step processes the Level 1 data to geophysical data (e.g. sea surface temperature, 
land surface temperature). 

5.1 Level-1 Processing Approach
SLSTR Level 1 processing is divided into two main steps:

 Instrument grid-processing
 Image grid-processing

5.1.1 Instrument grid processing
The instrument grid-processing has five sub-steps:

Figure 2: SLSTR Level 1 RBT instrument grid processing

First the source packets from the instrument are processed. Next the data is calibrated: For the 
IR channels this involves calculating the calibration offset and slope that describes the linear 
relationship between numerical counts and radiance; for the VIS/NIR/SWIR channels, the 
calibration is based on a diffuse calibration (VISCAL) target of accurately known reflectance 

Source 
Packet 

Processi
ng

IR 
Channel 
Calibrati

on

VIS/NWIR
/SWIR 

Channel 
Calibratio

n

Time 
Calibra

tion

Geoloca
tion



EUM/OPS-SEN3/MAN/17/921927
v1E e-signed, 4 July 2018

Sentinel-3 SLSTR Marine User Handbook

This Document is Public

Page 21 of 39

which is illuminated by the sun over a short segment of the orbit to enable a linear calibration 
relationship between the measured signal in each channel and the surface reflectance to be 
determined. Finally, the time and geolocation are calculated for each pixel.

5.1.2 Instrument grid processing
The image grid-processing re-grids the SLSTR measurements onto the nominal raster image, 
and tests each pixel for cloud. It also contains five sub-steps:

Figure 3: SLSTR Level 1 RBT image grid processing

In the re-gridding, the across and along track indices are calculated for each instrument pixel 
on either a 1 km raster image grid for the thermal IR channels or a 0.5 km grid for the visible, 
NIR and SWIR channels. The re-gridding is done by nearest neighbour resampling. Missing 
image pixels are then cosmetically filled. 

Surface Classification and the Basic Cloud Masking are then applied to each image pixel. 
Finally, the ECMWF meteorological fields are added on a sub-grid referred to as the tie-point 
grid.

5.1.3 Bayesian cloud detection
As of 04/04/2018, in addition to performing Basic Cloud Masking classifications, the L1 
marine processing chain implements a new Bayesian cloud detection algorithm. This offers 
improved performance over the basic cloud mask, with some caveats as noted in the section 
9.1.11.
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The data is strictly speaking not cosmetic, i.e. it is not made up, it is simply that an instrument 
pixel might be used more than once. Instrument pixels that are not used in generating the image 
pixels are included in the orphan pixels’ containers.
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Cloud detection is based on calculating a probability of clear-sky of each pixel based on the 
satellite observation, prior information about the atmosphere and surface conditions and the 
respective uncertainties in these variables. The current implementation uses ECMWF NWP 
data as input to simulate clear sky brightness temperatures and top of the atmosphere 
reflectances. The radiative transfer model used for simulating brightness temperatures is 
RTTOV. The probabilities have been included as experimental fields in the L2P WST product, 
are used to derive the Quality Levels, and are used for the cloud flag instead of the previously 
used basic cloud screening.

The Bayesian cloud mask is provided as a probability (0 – 1) in the L1 product. A threshold of 
0.1 (values less than) is used to identify clear sky pixels. However, users may wish to try 
different thresholds in their regions of interest by using the provided probabilities.

5.2 Level-2 Processing Approach
SLSTR Level-2 marine processing includes two primary steps:

5.2.1 SST retrieval algorithms
SST processing to generate five single-algorithm SST products using the method described in 
Section 4.3. These are provided in the Level 2 WCT product, which is only made available to 
the Cal/Val team via S3VT. The SSTs included are:

 1 km N2 SST
o Nadir single view using channels S8 and S9, i.e. 10.85 and 12 µm

 1 km N3 SST
o Nadir single view and all thermal channels (N2 plus S7, i.e. 3.7 µm)

 1 km N3R SST
o Like N3 but using the property of "aerosol robustness" and its associated 

method described in [RD-5]

 1 km D2 SST
o Like N2, except that BTs in both the oblique and nadir views are used

 1 km D3 SST
o Like N3, except that both views are used.

5.2.2 L2P processor
The L2P processing module, which generates a Group for High Resolution Sea Surface 
Temperature (GHRSST) compliant product. The L2P product contains only the best available 
SST for each pixel according to a set of rules define in the SLSTR Level 2 SST ATBD. In an 
extra step compared to the WCT product, the WST SSTs are atmospherically smoothed to 
reduce noise introduced in the retrieval process. Further details of the smoothing can be found 
in the SLSTR Level 2 SST ATBD. The L2P format data file is provided in the Level 2 WST 
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product. The SST scale factor and offset attributes also conform the GHRSST L2P 
specification. 
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6 SLSTR PRODUCTS AND FILE TYPES
There are three SLSTR marine product types that are disseminated to users:

 Level 1 RBT
This product provides radiances and brightness temperatures for each pixel, view and 
channel.

 Level 2 WCT (only available to Cal/Val users via S3VT)
This product provides sea surface temperature for all offered retrieval algorithms.

 Level 2 WST
This product provides the best SST at each SLSTR location in GHRSST L2P format.

SLSTR products are uniquely defined by their processing baseline configuration. This indicates 
both the software version used to generate the product as well as the specific set of auxiliary 
files used. This information is not currently available within the SLSTR products but can be 
found in the product notices.

6.1 File naming
The file naming is based on a sequence of fields [AD-3]: 
 
MMM_SS_L_TTTTTT_YYYYMMDDTHHMMSS_YYYYMMDDTHHMMSS_YYYYMMDDTHHMMS
S_<instance ID>_GGG_<class ID>.<extension>

Which for Sentinel-3 SLSTR data would be, for example:

S3A_SL_1_RBT____20160509T103945_20160509T104245_20160509T12490
7_0180_004_051_1979_SVL_O_NR_001.SEN3

 MMM – Mission id, e.g. S3A
 SS - Data source/consumer, e.g. SL is for SLSTR
 L - Processing level, e.g. 1 for L1 and 2 for L2
 TTTTT - Data Type ID, e.g. 
 “RBT___” = TOA radiances and brightness temperatures
 “WCT___” = Retrieved SST for all algorithms
 “WST___” = Best SST in GHRSST L2P format
 YYYYMMDDTHHMMSS - 15 character Data Start time, then Data Stop time then Creation 

Date
 <instance id > - 17 characters e.g. 0180_004_051_1979 is duration, cycle number, relative 

orbit number and frame along track coordinate
 GGG – Product Generating Centre e.g., EUM = EUMETSAT and SVL = Svalbard Satellite Core 

Ground Station
 <class ID> - 8 characters to indicate the processing system e.g., O_NR_001 is the software 

platform (O for operational, F for reference, D for development and R for reprocessing), 
processing workflow (NR for NRT, ST for STC and NT for NTC) and 3 letters/digits indicating 
the baseline collection.

 <extension> - Filename extension, SEN3
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6.2 Data format
The SLSTR data format follows the format defined for each Sentinel-3 product, i.e. the PDGS 
product specification, and is based on Sentinel-SAFE. Each product package includes:

 A manifest file containing a metadata section and a data object section (in XML 
format).

 At least one measurement or annotation data files (in NetCDF-4 format).

The manifest file - xfdumanifest.xml - explains the contents of the package at an overarching 
level. 

L1 & L2 product packages contain:

manifest file 
(xfdumanifest.xml)

NetCDF measurement 
and annotation data files

Figure 4: SLSTR file format

6.3 Level 1 Product Contents
The SLSTR Level 1 RBT product is composed of one manifest file and several measurement 
and annotation data files (between 77 and 111 files depending on the processing parameters). 
For thermal IR and fire channels (labelled as S7 to S9 and F1, F2 for fire channels), the 
radiometric measurements are expressed in TOA Brightness Temperature (BT). In the case of 
visible / NIR / SWIR channels (labelled as S1 to S6 channels), these measurements are 
expressed in TOA radiances.

The radiometric measurements are indexed according to the across track and along track 
direction:

 On a 1 km grid for brightness temperature

 On a 0.5 km grid for radiances. In this case, three stripes are distinguished: A, B and 
TDI, with TDI a derived product from A and B stripes. Only the stripes selected in the 
processing configuration file are available.

They contain, for each pixel on the full resolution grid and for each orphan pixel, the radiance 
or brightness temperature and their associated exception flags. These files are all written in 
NetCDF-4 format and include dimensions, variables and associated attributes.

The SLSTR Level 1 RBT product also contains annotation data files are also written in 
NetCDF-4 format:

 Quality flags concerning cloud flagging and scan and flip mirror positions
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 Surface pixel classification information

 Meteorological annotations

 Quality annotations, such as estimates of detector noise measured at VISCAL or black 
bodies

 Arrays of indices to retrieve the position of each pixel in the instrument measurement 
frame

 Cartesian and geodetic coordinates associated with the radiometric measurements and 
the tie-point grid defined for SLSTR.



6.4 Level 2 Product Contents
The SLSTR Level 2 products are composed of one manifest file and between 1 and 21 files 
depending on the package several measurement and annotation data files depending on the 
product.

The measurement and annotation data files are in NetCDF-4 format, and include dimensions, 
variables and associated attributes. The included parameters are provided only on the 1 km 
grid, indexed by their along and across track indices. For measurement files:

 SL_2_WCT: 
Contains five sea surface measurement files. These five SST measurement datasets are 
generated on the 1 km image grid and are indexed across track and along track. In 
addition to SST, the Level 2 WCT provides the SST uncertainties and exception flags 
derived from SLSTR Level 1 RBT product, and includes parameters directly taken from 
SLST Level 1 RBT product, associated with re-gridded and orphan pixels:

 Quality flags concerning cloud flagging, scan and flip mirror testing, and results 
of Bayesian cloud detection.

 Arrays of indices to retrieve the position of each pixel in the instrument 
measurement frame and their time stamps

 Cartesian and geodetic coordinates associated to the radiometric measurements 
and to the tie-points grid defined for SLSTR

 Meteorological annotations.

 SL_2_WST: One measurement file, giving the latitude, longitude, time and sea surface 
temperature value, in GHRSST L2P format. It includes a single SST field derived from 
the best performing single-coefficient SST field for any given part of the swath, plus 
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several auxiliary fields to aid interpretation of the SST field. Each SST, previously 
generated during in the Level 2 WCT product, is atmospherically smoothed using a 3-
by-3 pixel average of the difference between the SSTs and the mean S8 BT value.

The file provides standard GHRSST required fields, including:

 Latitude and longitude of each pixel

 SST value

 The SST measurement time deviation from a reference time

 The Single Sensor Error Statistic (SSES) bias and standard deviation. Please 
consult section 8 on how to apply these.

 A quality flag per pixel 

 Additional parameters (wind speed at 10 m, the fractional sea-ice contamination, 
the aerosol contamination indicator for each pixel) to aid in using the SST value

In addition, several experimental fields are provided giving:

 The algorithm used to generate the SST

 The difference between the dual-view and nadir-only SSTs for the dual-view part 
of the swath

 TOA BTs and NeDTs 

 Pixel level theoretical uncertainties

 The probability of cloud in each pixel as estimated by Bayesian cloud detection 
for both the nadir and oblique views.
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7 HELPDESK, PRODUCT DISSEMINATION AND ARCHIVE

7.1 Helpdesk
The EUMETSAT User Helpdesk is available to all users during standard office hours. The 
service provides support on data access and product usage and application. All user requests 
on the EUMETSAT SLSTR Marine data products should be directed to the EUMETSAT Help 
Desk ops@eumetsat.int. 

7.2 Data access routes
EUMETSAT provides data access through several routes, depending on your preferred 
delivery route and the latency of the data that’s needed. This central catalogue lists all 
EUMETSAT missions (Meteosat, Metop, and Jason-2) in addition to the Copernicus Sentinel-3 
marine and atmosphere products.
 

Access route

Access method

Starting point eoportal.eumetsat.int

Internet 
connection

Historical 
data 

Data 
Centre 
Long-
Term 

Archive

Recently acquired data (last 12 
months)

Copernicus 
Online Data 

Access 
(CODA)

Online 
Data 

Access 
(ODA) for 

S3VT 
members

Telecoms 
satellite 

link

EUMETCast: 
subscription 

request

Figure 5: Data access routes

The starting point is usually the EUMETSAT EO Portal (EOP) for which you need to create a 
user account. Please see the online tutorial for further information:

Earth Observation Portal Tutorial - Registering. 
Once registered you can then access Copernicus Sentinel-3 marine products from the links in 
the following table. If you already have an EOP account then please request access to the other 
services by emailing the EUMETSAT Help Desk.
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EUMETCast
eumetcast.com 

Multi service push dissemination system based 
on multicast technology, which is transported 
to the user via satellite (EUMETCast Satellite, 
with coverage over Europe, the Middle-East 
and Africa).

CODA
coda.eumetsat.int

Download service offers all Sentinel-3 marine 
and atmospheric products through a rolling 
buffer that (at a maximum) will span 12 
months.

Data Centre Long-Term 
Archive
archive.eumetsat.int

Ordering application that enables users to 
browse and select from EUMETSAT’s long-
term archive products, including the 
Copernicus Sentinel-3 marine and atmospheric 
products.

EUMETView
eumetview.eumetsat.int

A visualisation service that allows users to view 
EUMETSAT’s data and Copernicus Sentinel-3 
marine data in an interactive way using an 
online map view.

Table 2: Data access locations

 For those who would like to receive the data over a satellite connection: EUMETCast 
is EUMETSAT’s primary dissemination method.

 For those downloading data from the internet: If you are interested in just recently 
acquired data then the best access route is the Copernicus Online Data Access (CODA) 
that provides an interactive interface. Batch scripting is also possible. In order to 
discover CODA’s functionalities and example scripts to download Sentinel-3 data 
using CODA APIs, read the User Guide: https://coda.eumetsat.int/manual/CODA-user-
manual.pdf.

 If you would like to access an historical time-series: The Data Centre would be your 
route; this allows you to access either the global dataset (under the Products tab, best 
entering OLCI as a search term so you see just these products), or large regions of 
interest such as the North Atlantic and Mediterranean Sea (under the Sentinel-3 
Datasets tab). On subsequent screens, you can then define a region of interest and time-
range before ordering the products.

For those who are members of the Sentinel-3 Validation Team (S3VT), there is also FTP access 
via the Online Data Access (ODA) that allows you to access both datasets and mini-files (small, 
extracted, areas of interest). 

For further details please contact the EUMETSAT User Helpdesk.
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7.3 User Products Dissemination Concept

All Sentinel-3 marine products are disseminated in Product Dissemination Units (PDUs) to 
ease the online dissemination and data handling for the users. The PDU is a slice of data and is 
defined per product type. Two kinds of PDU are defined for Sentinel-3 marine products:

1. A frame is identified by means of a fixed reference system based in along track 
coordinates and along orbit cycle coordinate. The along-track coordinate identifies the 
product frame start point with respect to a fixed orbit position (like the ANX). Each 
frame is stepped by a constant time interval along the orbit track. The along orbit cycle 
coordinate identifies the relative orbit number within the orbit cycle.

2. A stripe coincides either with the acquisition dump or with a defined acquisition time 
segment whose length may differ according to the instrument type.

7.4 Software Tools

7.4.1 Sentinel-3 Toolbox
The Sentinel-3 Toolbox consists of visualisation, analysis and processing tools for the 
exploitation of OLCI and SLSTR data, and is an extension to the SeNtinel Application Platform 
(SNAP) that can be downloaded from the Science Toolbox Exploitation Platform (STEP)2.

Once SNAP has been downloaded and installed it is possible to open L1 and L2 SLSTR 
products. If you need questions answered about the SNAP tool and associated Sentinel 
toolboxes then there’s an on-line forum3. 

7.4.1.1 Installing the toolbox
In case you haven't already done so, click/double-click the installer and follow the on-screen 
instructions to install SNAP.

7.4.1.2 Opening a Sentinel-3 product
Sentinel-3 products are provided not as single files but as a collection of files contained within 
a folder. The folder name is the actual product name, ending with “.SEN3”. Each folder 
contains a metadata file named xfdumanifest.xml and at least one NetCDF file. Each NetCDF 
file contains a subset of a Sentinel-3 product's content.

2 STEP download page: http://step.esa.int/main/download/ 
3 step forum: http://forum.step.esa.int/

SLSTR NRT/NTC L1 RBT and NRT L2 WCT and WST products are distributed as 
frames.

SLSTR NTC L2 WCT and WST products are distributed as stripes
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To open a Sentinel-3 product, you can either:

 Drag and drop the whole folder into the "Products View"

 Drag and drop the xfdumanifest.xml-file into the "Products View"

 Choose "File->Open Product", navigate to the xfdumanifest.xml file and click "Open 
Product"

 Choose "File->Import Raster Data->Multispectral Data->SENTINEL-3", navigate to 
the xfdumanifest.xml file and click "Open Product"

You can also open single NetCDF files. However, keep in mind that these will only show a 
part of the Sentinel-3 product and, in most cases, lack geocoding.

For a video example please see the following video from the EUMETSAT remote sensing 
scientist for SLSTR:

https://www.youtube.com/watch?v=lKyUeN3uS0Q&t=133s

When opening and SLSTR Level 1 RBT product you will be prompted as to which resolution 
you wish to open:

 500 m: Will open an RBT product and display both the 500 m and 1 km bands; the 1 
km bands are sub-sampled onto the 500 m grid;

 1 km: Will open an RBT product and display the 1 km bands only (you will not be able 
to access bands S1 to S6).

7.4.1.3 Basic functionality
Once you have opened a product in SNAP there are many different things you can do next. 
Here are some basic activities:

 Displaying a colour composite: choose "Window->Open RGB Image Window".

 Displaying spectra, choose "Optical->Spectrum View".

 Displaying flags/masking the data: using the Mask Manager.

 Displaying uncertainty information, see the Uncertainty Visualisation tool window 
present in the bottom left.

7.4.2 View the contents of a NetCDF file?
If you want to browse the detailed contents or metadata of a NetCDF file (as opposed to visually 
looking at and interrogating the array in SNAP) then there are interactive tools such as Panoply4 
alongside Linux commands such ncdump.

4 Panoply download: https://www.giss.nasa.gov/tools/panoply/ 
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7.4.3 Cerbere and Felyx
More advanced users may wish to use Cerbere and Felyx. Felyx is a free software solution, 
written in python and JavaScript, whose aim is to provide EO data producers and users with an 
open-source, flexible and reusable tool to allow the quality and performance of data streams 
(satellite, in situ and model) to be easily monitored and studied. For more information please 
consult the Felyx User Guide:

 http://felyx.readthedocs.io/en/latest/user_guide.html

In addition to Felyx is the Cerbere, free and open source python modules for the reading, 
interpretation, and writing of (primarily ocean) geophysical data, including Sentinel-3. For 
further information visit the Cerbere pages at:

http://cerbere.readthedocs.io/en/latest/. 

An example for reading SLSTR data is given at:
http://cerbere.readthedocs.io/en/latest/recipes/reading_s3_slstr.html
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8 DATA QUALITY
A summary of all known product issues is provided in the product notices. These can be found 
on the EUMETSAT web pages at:

https://www.eumetsat.int/website/home/Data/CopernicusServices/Sentinel3Services/ 
SeaSurfaceTemperature/index.html 

Routine reporting of SLSTR data quality is provided in the SLSTR Cyclic Report. These are 
generated every cycle (roughly every 27 days or 501 orbits) and can be downloaded from:

https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-3-slstr/data-quality-reports.

Validation results from comparisons to drifting buoys show that the difference between SLSTR 
and drifting buoys is given in Table 3.:

Retrieval Quality Level Number of 
matchups Median (K)

Robust 
Standard 

Deviation (K)
N2 5 692 -0.19 0.28
N2 4 5413 -0.21 0.41
N2 3 1172 -0.21 0.73
N2 2 110 -0.21 0.95
N3 5 4956 -0.18 0.25
D2 5 729 -0.20 0.29
D2 4 4804 -0.13 0.31
D2 3 179 -0.10 0.42
D3 5 3163 -0.12 0.26

Table 3: SLSTR validation against drifters

These results compare SLSTR SSTskin to drifter SSTdepth. The SSES_bias field has not been 
applied to the results. A wind speed filter of 6 ms-1 has been applied to remove all match-ups 
below this wind speed. A median difference of -0.13 K is expected for this type of comparison.

SSES values are provided for each retrieval and each quality level. SSES biases and standard 
deviations for quality levels below level 5 are currently not well prescribed. Consequently, 
users are advised to use, by default:

 Only D2 and D3 SSTs for reference applications, and
 Only level 5 quality data
 Where the application allows, users may use lower quality data for nadir SSTs (or apply 

their own Bayesian cloud probability threshold), but quality level 4 or lower dual view 
data (D2/D3) should never be used.

For users who wish to use the nadir-only retrievals – N2 and N3 – you are advised to only use 
data where the satellite zenith angle is < 55 degrees.

The SSES bias has not been applied to the SST product. Users are reminded to apply 
this before using the data.
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9 USER BEWARE!
This section contains details of SLSTR specific features that you should be aware of.

9.1.1 Product Grids in RBT and WCT Products
Two grids are defined for SLSTR outputs: the measurement grid, also called instrument 
reference grid, and a raster image grid. Each grid contains several variations according to the 
different instrument view and resolution. For operational reasons, all SLSTR L1 and L2 files 
are defined on the image grid. However, the products contain the required information to 
reconstruct the instrument grid if necessary.

The instrument grid is the native grids on which the SLSTR collects data as it scans. A scan 
number identifies the number of the scan line, starting at the ANX (point at which the satellite 
crosses the equator from South to North). A pixel number identifies the pixel count of any scan. 
A detector number then maps, for each pixel, the row and the column number (aligned with the 
along track and across track directions) onto a two-dimensional matrix of detectors. The image 
grid is locally Cartesian and is aligned with the sub-satellite track. All data are provided on this 
grid to provide raster "image-like" data.

A lower resolution tie-point grid is also defined, and annotations such as meteorological or 
viewing geometry data are provided on this grid. It is aligned with the 1 km and 0.5 km image 
grids and is regular in distance across track (16 km) and regular in time along track (1 km).

9.1.2 Aligning the product grids in RBT and WCT Products
To correctly use the three grids together (for RBT and WCT users only) you need to find the 
offsets of the three grids relative to each other. This information (known as track_offset) can 
be found in either the manifest file or in the datasets. An example of the three product grids for 
one granule is shown in Figure 6, which plots the geodetic coordinates for the tie-point grid in 
blue, the nadir grid in green and the oblique grid in red. Also, shown with the black line in the 
centre of the oblique view is the location of the SSP. 

Figure 6: (Left) Example SLSTR product grids showing the tie-point (blue), nadir (green and oblique (red) 
geodetic coordinates. The SSP is indicated by the black line.

The tie-points are spaced every 16-km across-track and every 1-km along-track; the nadir and 
oblique grids are spaced every 1-km in both along-track and across-track dimensions. To use 
the grids together you must first interpolate any data on the tie-point grid in the across-track 
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dimension to the same resolution as the measurement grids. Then, using the track-offsets, you 
can align all three grids to the SSP.

9.1.3 Mixed SST fields in WST Product
The SLSTR Level 2 WST product contains the best SST for each location across the swath. 
Please use the experimental field “sst_algorithm_type” to discriminate between the various 
retrievals (N2, N3, D2 or D3). An example is shown below in Figure 7.

Figure 7: (Left) Full swath WST SST image and (right) “sst_algorithm_type” showing the dual-view (cyan) 
and nadir-only (purple) regions.

 For reference work, we advise users to only use dual-view (D2 or D3) SSTs.

9.1.4 Quality level and SSES in WST Product
The SLSTR Level 2 WST files contain the standard GHRSST SSES and quality level fields. 
For reference use we advise users to default to using data of quality level 5 only (see section 8, 
and only dual-view SSTs (see section 9.1.5).

9.1.5 Data over all water bodies in WCT and WST Products
The SLSTR Level 2 WCT and WST products contain SST over inland water bodies. An 
example is shown below in Figure 8.

Figure 8: SLSTR SST image of the Amazon estuary in South America showing the scale of inland water 
bodies provided in SLSTR data.

For WCT users:
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If you do not wish to use inland water bodies in your analysis or conversely only wish to use 
inland water bodies then please use the confidence flags.

For WST users:

If you do not wish to use inland water bodies in your analysis or conversely only wish to use 
inland water bodies then please use bits 4 (lakes) and 5 (rivers) of the “l2p_flags” variable to 
distinguish them 

9.1.6 NeDT in WST product
The SLSTR Level 2 WST products contain estimates of the NeDT for the nadir-only BTs 
recorded in the three IR channels. An example is shown in Figure 9. Small pixel to pixel 
variability is clearly seen in Figure 9 owing to the instrument design. Each of the three IR 
channels has two detectors, with S8 and S9 also having two integrators. Consequently, a 
checkerboard pattern is seen that varies every 20 rows, corresponding to the calibration 
averaging window used to calculate the gains and offsets for each detector. NeDT will also 
vary with scene temperature – the underlying large scale structure seen in Figure 9.

Figure 9: Example NeDT image for channel S8

9.1.7 Using flags in RBT and WCT Product
The SL_1_RBT and SL_2_WCT products have several annotation datasets to help interpret 
the measurement data. The most used file will be the product quality flags, which are provided 
for each measurement grid and view combination. In this file are a set of masks summarising 
the location of the pixels, the basic cloud mask and instrument errors.

The location of the pixel and a summary cloud flag can be found in the confidence variable. 
Bitmask. The content is listed below in Table 4.

Bit Mask name Meaning if set
0 coastline Coastline in field of view
1 ocean Ocean in field of view
2 tidal Tidal zone in field of view
3 land Land in field of view
4 inland_water Inland water in field of view
5 unfilled Unfilled pixel (1 if this pixel is never tested or filled)
6 spare spare
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Bit Mask name Meaning if set
7 blanking_pulse RADAR active
8 cosmetic Cosmetic fill pixel
9 duplicate Pixel has a duplicate
10 day Pixel in daylight
11 twilight Pixel in twilight
12 sun_glint Sun glint in pixel
13 snow Snow
14 summary_cloud Summary cloud test
15 summary_pointing Summary pointing

Table 4: SLSTR confidence bitmask

For example, to check if a pixel has been classified for land then you check to see if bit 3 has 
been set; for the summary cloud flag, you check if bit 14 has been set.

For users who wish to look at the individual cloud tests rather than use the summary flag then 
these are provided in the cloud variable. The content of the cloud variable is given in Table 5. 
Users should note that the thermal_histogram test is not included in the summary_cloud flag.

Bit Mask name Meaning if set
0 visible Visible channels cloud test
1 1.37_threshold 1.37 threshold test
2 1.6_small_histogram 1.6 µm small-scale histogram test
3 1.6_large_histogram 1.6 µm large-scale histogram test
4 2.25_small_histogram 2.25 µm small-scale histogram test
5 2.25_large_histogram 2.25 µm large-scale histogram test
6 11_spatial_coherence 11 µm spatial coherence test
7 gross_cloud 12 µm gross cloud test
8 thin_cirrus 11 µm/12 µm thin cirrus test
9 medium_high 3.7 µm/12 µm medium/high level test
10 fog_low_stratus 11 µm/3.7 µm fog/low stratus test
11 11_12_view_difference 11 µm/12 µm view difference test
12 3.7_11_view_difference 3.7 µm/11 µm view difference test
13 thermal_histogram 11 µm/12 µm thermal histogram test
14 Spare spare
15 spare spare

Table 5: SLSTR cloud bitmask

9.1.8 Converting from Brightness Temperature to Radiance in RBT Product

The BT measurements provided by SLSTR are integrated spectral radiances across the range 
of the spectral filters used in each of the spectral bands, S7, S8 and S9. These can be converted 
to a measure of the integrated radiances by inverting the radiance to BT look up tables.
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To do this a user must:

1. Obtain the radiance to BT look up tables:

These are Auxiliary Data Files (ADF) with a filename like:

S3A_SL_1_N_S8AX_20000101T000000_20991231T235959_20151214T120000______
_____________MPC_O_AL_001.SEN3

N is the view it can be either N for nadir or O for oblique
S8 is the spectral channel

2. Read the radiances and temperatures variables

The file contains and array of temperatures and the radiance to temperature lookup table.

3. Interpolate the radiances for the BT at each pixel.

9.1.9 Converting from Radiance to Reflectance in RBT Product

The SLSTR shorter wavelength channels (S1 to S6) provide measurements of TOA radiances 
in units of mW m-2 sr-1 nm-1. These values are often not useful when comparing or merging 
data from multiple sensors as they invariably have different sun angles at the time of 
measurement and different spectral profiles.

A more useful unit to compare sensors is normalised reflectance, which can be generated from 
the radiance using the following formula:

reflectance = PI * (ToA radiance / solar irradiance / COS(solar zenith angle))

Note: You must use the solar irradiance at TOA from the “quality” dataset for the respective 
channel.

9.1.10 Range of valid brightness temperatures in channels S7, S8 and S9

The BT limits (BT_min and BT_max) for S7, S8 and S9 are the cut-off in the processor outside 
of which the flags are set for invalid radiance. The current values are:

 S7: 150 - 305 K
 S8: 150 - 350 K
 S9: 150 - 350 K

    
The actual limits possible from the detector dynamic range modify these in the following way:

 S7: values can fill all of BT_min – BT_max range but accuracy drops off sharply below 
215 K. The counts-to-BT conversion in the lower end is essentially flat, so a change of 
1 count results in a large change in BT, which results in very large rapid jumps in BT 
below 200 K.
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 S8: lower limit currently set to approximately 180 K (depends on which of 2 detectors 
is used) - below that, no-signal flag set. Upper limit is currently approx. 347 K (above 
that saturation flag set).

 S9: values can fill all of the BT_min to BT_max range.

The information in this section was provided by Ed Polehampton (STFC RAL Space) as part 
of the Sentinel-3 Mission Performance Centre (MPC) SLSTR Expert Support Laboratory 
(ESL). 

9.1.11 Bayesian cloud flagging caveats
Although there is a significant improvement compared to the basic cloud mask, some residual 
issues have been identified: 

 The false alarm rate is higher than would be desired indicating some over-flagging of 
clear sky as cloud. 

 The Bayesian cloud mask is sensitive to ocean fronts resulting in over-flagging along 
the front itself. 

 The Bayesian cloud mask is sensitive to surface reflectance resulting in over-flagging 
in regions of upwelling and coastal zones.

 For the Bayesian cloud mask, over-flagging is more pronounced in the coastal region 
for NRT products. Until the issue is resolved recommendation is to use NTC products 
if sea surface temperature variable is used from the coastal region.

9.1.12 VIS/SWIR radiometric calibrations versus OLCI
MPC analyses shows that the radiometric calibrations for channels S1 to S3 are within 1% of 
OLCI values. Conversely, S5 and S6 show a discrepancy of 12% and 20%, respectively. 
Despite this, no calibration adjustments have been made in order to retain operational cloud 
processing. Users are recommended to adjust the S5 and S6 reflectances by factors of 1.12/1.15 
and 1.20/1.26 in nadir/oblique views. However, as the uncertainty estimates on the differences 
are yet to be evaluated, and as these corrections may be scene dependant, users are advised to 
use caution pending a full MPC investigation.


